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Purpose  

This document includes important, late-breaking information about this release of Oracle’s 
Hyperion® Planning – System 9. Review this information thoroughly before installing Planning. 

For information about issues in the following products, see the corresponding Readme: 

• For Hyperion® Shared Services, see the Hyperion Shared Services 9.2.1 Readme. 

• For Hyperion® Business Rules, see the Hyperion Business Rules 9.2.1 Readme.  

• For Hyperion® Smart View for Office, see the Hyperion Smart View for Office 9.2.1 
Readme. 

 

Note: Use the Hyperion System 9 Planning 9.2 User’s Guide, Hyperion System 9 Planning 9.2 
Administrator’s Guide, and Online Help systems to learn how to use Planning. For an overview 
of the new functionality in this release, see the Hyperion System 9 Planning 9.2 New Features 
document. 

Top

Hyperion License Compliance 

Beginning with this release, Hyperion® License Server™ and standalone license files are not 
used for license management. Instead, administrators need to audit product use.  

Administrators need to audit product use for all products, even products that did not previously 
require a license server or standalone license file. If you are updating a product that previously 
used a license server or standalone license file, to ensure compliance with your license 
agreement, you also need to edit a properties file to activate or deactivate features in 
accordance with what you have purchased. 

For more information about license compliance, see the Hyperion License Compliance Readme 
(hyp_license_compliance_readme_921.pdf), which you can find on the Oracle® E-Delivery 
site or the product DVD. 

Note that references to Hyperion License Server may still exist in some of the documentation. 

Top

Release 9.2.1 Product Name Changes 

The user interface in Oracle’s Hyperion products has been rebranded for Release 9.2.1 to 
incorporate a new logo, new copyright and trademark information, and new product names. 
Products referred to in this Readme and in the Installation Guide also reflect the current 
product names. However, because the core documentation for Release 9.2.1 has not been 
updated, products are still referred to by their previous names in the documentation. 

http://edelivery.oracle.com/
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Documentation 

References to Hyperion Download Center may still exist in the documentation. Hyperion 
products and documentation are now available on the Oracle Technology Network or the 
Oracle® E-Delivery site.  

Top

Supported Languages 

Planning 9.2.1 is released in the following languages: 

• English 

• French 

• German 

• Spanish 

• Turkish 

• Russian 

• Japanese 

• Korean 

• Simplified Chinese 

• Traditional Chinese 

• Brazilian Portuguese 

For this release of Planning, only extended ASCII characters are supported in a UNIX 
environment. 

Top

Installation Updates 

Before You Begin an Installation 
This section includes important information about installing this release of Planning. 

Before installing Planning or any of its components, read the cover letter and all of the 
installation instructions in the Hyperion System 9 Installation Start Here and the Hyperion 
Planning - System 9 Installation Guide. 

Note: Disregard any references to the Hyperion Business Performance Management 
Deployment Guide in the Hyperion Planning - System 9 Installation Guide. The Hyperion 
Business Performance Management Deployment Guide does not support this release of 
Planning. 

New Business Rule Configuration 
In Planning 9.2.1, runtime processing for Business Rules has been improved to enhance 
performance. The installation of all components remains the same as in earlier releases. The 
configuration of Essbase® Administration Services and Planning are the enhanced items. You 

http://www.oracle.com/technology/index.html
http://edelivery.oracle.com/
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should register Administration Services with Shared Services before registering Planning with 
Shared Services. 

Note: If there are multiple registrations of Administration Services with Shared Services, the 
last configuration is saved and used when Planning is registered with Shared Services.  

This is necessary as Planning now leverages the HBRServer.properties file that is registered 
with Shared Services as part of the Administration Services configuration. Additionally, when 
creating the Planning properties file with the Hyperion® Configuration Utility, you no longer 
need to "Enable HBR" and fill in the appropriate Administration Services/Business Rules 
connections. This information is now managed within the HBRServer.properties file that 
Planning reads from Shared Services. 

Deploying and Configuring Oracle Application Server 10g 
To deploy and configure Oracle Application Server 10g for Planning: 

Note: Oracle 10g Application Server is supported in English only. 

1. Start the Oracle Application Server by opening a Web browser, set the URL to 
http://localhost:1810 or http://<servername>:<port>, and specify the username and 
password that you created during Oracle installation. 

Note: The default login ID for a new OC4J instance is OC4Jadmin. The password is specified 
during the Oracle 10g installation. Contact your Oracle Administrator for more information. 

2. From the Oracle application server administrator’s console, stop Planning, and undeploy the 
HyperionPlanning.ear file: 

a) In the System Components section of the Oracle Enterprise Manager main page, 
select the HyperionPlanning Instance. 

b) In the OC4J: Planning page, select Applications. 

c) Click Undeploy. 

d) When the process is finished, delete the HyperionPlanning folder (if it exists) 
from: 

c:\..\j2ee\home\application-deployments  

and 

j2ee\home\applications 

3. If the OC4J instance was deleted, configure the environment variables: 

a) On the Oracle Enterprise Manager Application Server Main page, in SystemComponents, 
select HyperionPlanning. 

b) On the OC4J: Planning page, select Administration. 

c) On the Administration page, select Server Properties. 

d) In Environment Variables click Add Row and add an environment variable named 
HYPERION_HOME; for example, /vol1/hyperion. 

http://localhost:1810/
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e) In Environment Variables, click Add Row and add an environment variable named 
PLANNING_HOME; for example, /vol1/hyperion/Planning. 

f) In Environment Variables, click Add Row and add an environment variable called:  
 
LIBPATH for AIX systems 
 
LD_LIBRARY_PATH for Solaris systems 
 
PATH for win32 systems 
 
The variable value is the bin directory of the path for your Essbase runtime client. 
 
Example:/vol1/hyperion/common/EssbaseRTC/9.2.1/bin 

g) Click Apply to save the configuration. 

4. Redeploy Planning with the new HyperionPlanning.ear file, using the instructions in the 
Hyperion Planning – System 9 Planning 9.2.1 Installation Guide. 

5. Copy the cls-9_2_0.jar file from: 

/vol1/hyperion/common/CLS/9.2.1.0/lib/ 

to: 

/vol1/oracle/OraHome1/j2ee/HyperionPlanning/applications/HyperionPlanning/ 
HyperionPlanning/WEB-INF/lib/ 

6. Restart the HyperionPlanning Instance for Oracle10g:  

a) In the System Components section of the Oracle Enterprise Manager main page, click 
the home system component. 

b) Click Restart. 

c) Click Yes to proceed. 

7. Test to make sure you can open Planning by navigating to: 
http://localhost:8300/HyperionPlanning/LogOn.jsp.  

General Installation Issues 

Upgrading Planning 
When you run the Hyperion Configuration Utility after upgrading Planning from release 9.0 to 
release 9.2.1, the product selection page may display multiple listings for Planning or may not 
list Planning at all. If this problem occurs, perform these steps: 

1.   Navigate to this directory: 
 
Windows: <HYPERION_HOME>\common\config\product\<product>\<release number> 
UNIX: <HYPERION_HOME>/common/config/product/<product>/<release number> 
 
where <HYPERION_HOME> is the Hyperion Home location on the machine and  
<product> is the product name or abbreviation. For example: 

http://localhost:8300/HyperionPlanning/LogOn.jsp
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Windows: c:\hyperion\common\config\product\planning\9.2.1.0 

 UNIX: /vol1/hyperion/common/config/product/planning/9.2.1.0 

2.   Delete the oldest *.xml file from this directory. 
 
For example, if the directory contains two files named planning_1.xml and 
planning_2.xml, delete the older file. 

3.  Re-run the Hyperion Configuration Utility.  

Desktop Logon Required 
Administrators must log on to the Desktop once before any users can log on to Planning on the 
Web. During the Desktop logon, updates are applied with no user interaction required. After the 
initial Desktop logon, all users can log on to Planning on the Web as usual. 

Configuring WebLogic 8.1.4 
• To start WebLogic 8.1.4 successfully on Windows 2003 64-bit Itanium systems, in the 

startHPServer.bat file, add lib\ to the path for commons-pool-1.1.jar, after both 
occurrences of 9.2.0: 

;%HYPERION_HOME%\common\SharedServices\9.2.0\lib\commons-
collections.jar;%HYPERION_HOME%\common\SharedServices\9.2.0\lib\commons-
pool-1.1.jar 

The path to the startHPServer.bat file is: 
$HYPERION_HOME/HyperionPlanning/AppServer/InstalledApps/WebLogic/8.1/HPDoma
in 

• To configure Planning for SSL and WebLogic 8.1.4, or to configure Planning on Windows 
2003 64-bit Itanium systems: 

1. Install Planning and deploy it with WebLogic 8.1.4 as directed in the Hyperion System 9 
Planning Installation Guide. 

2. Start $HYPERION_HOME/HyperionPlanning/AppServer/InstalledApps/WebLogic/8.1/ 
HPDomain/startHPServer.bat. 

3. Log on to the WebLogic console using this URL:  
http://<machine name>:8300/console.  

4. From the right pane of the WebLogic console, under Domain Configuration, select 
Servers.  

5. From the HP->Servers page, select HPServer. 

6. From the HP->Servers->HPServer page, select the General tab and enable SSL 
Listen Port.  

7. Click Apply twice. 

8. Add this line to the HspJSHome.properties file, at the end of the global section: 

APP_SERVER_TYPE=WebLogic 
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 A sample path for the HspJSHome.properties file is: 
$HYPERION_HOME/HyperionPlanning/AppServer/InstalledApps/WebLogic/8.1/ 
HPDomain/applications 

9. Restart the Planning server.  

Other Installation Issues 
• On the application server panel in Hyperion Configuration Utility, WebSphere 6 and 

WebLogic 9 are displayed as choices for auto-deployment. WebSphere 6 and WebLogic 9 
can only be deployed manually for this release. Do not select the auto-deployment 
option for WebSphere 6 or for WebLogic 9. Follow the instructions in the product 
installation guide to manually deploy to these application server versions.  

• When uninstalling Planning, the AppServer directory is not removed, which requires 
manually removing files and undeploying the Web application server. 

• When you deploy Planning on WebSphere 6.0.2.11, the system becomes unresponsive 
after users send data to the Web application server. To work around this issue, deploy 
Planning using Tomcat 

• You cannot configure Planning on Windows 2003 with 64-bit Itanium. 

• On the Shared Services registration panel in the Hyperion Configuration Utility in the 
Server field, you can enter only English alphanumeric characters and these special 
characters: 

- dash ( - ) 

- underscore ( _ ) 

- dot (.) 

• To use the Suppress Missing Block option as a row property when designing data forms, 
you must use Administration Services 9.0.1 or higher. Suppress Missing Block enhances 
performance of the Suppress Missing Data setting when suppressing a large number of 
rows. 

• If the destination path for the Planning properties file contains spaces, an error message 
displays when you create the Planning properties file. The properties file generator in the 
Hyperion Configuration Utility does not support paths that include spaces.  

• If you are upgrading from Planning 3.5x or 4.0.x, use the Migrating Users Utility 
(UserMigrUtil) to delete underscore users. See the Hyperion System 9 Planning 
Installation Guide for more information. 

• On the Country Selection Panel in the installer, do not choose "Japan" as the language if 
you are installing on an operating system that does not recognize Japanese characters. 
Instead, choose the "Other" country option to ensure that the license panel in the 
installer displays correctly. 

• When installing Shared Services on the HP-UX 64-bit platform, you must install as the 
root user. If you do not install as root, JDK is not installed properly.  

• If you are deploying to Apache Tomcat on a supported 64-bit platform, the machine 
hosting Tomcat must have a 32-bit JDK installation. 

• In a distributed configuration, during creation of the properties file using the Hyperion 
Configuration Utility, you must specify the location on your Planning Windows 32-bit 
machine (for example, <drive_letter>:\Hyperion\HyperionPlanning\Utils). 

• In addition to native Hyperion single sign-on, Hyperion products can integrate with 
Netegrity SiteMinder, a Web access management solutions provider. Planning supports 
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single sign-on with SiteMinder. To enable Planning to function correctly with SiteMinder, 
ensure that the following conditions are met:  

The product URL, such as http://<server>:8300/HyperionPlanning/, is protected in 
the SiteMinder Policy Server.  

Shared Services uses UserMgmtConsole.jsp, Dimensions.jsp, Tasklist.jsp and 
FormManagement.jsp to communicate with Planning, and all users must have 
unprotected access to the URL.  

For details about unprotecting specific URLs, refer to the SiteMinder Policy Server 
Administration Guide.  

• Uninstalling Hyperion – System 9 products on Japanese or Korean versions of Microsoft  
Windows using the Add/Remove Program may cause an operating system crash. To 
avoid the potential problem when uninstalling, locate the uninstall.exe for the product 
(located in C:\Hyperion\HyperionPlanning\uninstall\) and double-click the 
executable to remove the products manually. 

• To avoid performance issues, during installation turn off any screensavers that are 
running on your Planning servers. 

• Due to an InstallShield issue, if you attempt to install Planning on a computer where PC 
Anywhere is installed, Java Virtual Machine (JVM) does not get installed. To work around 
this, uninstall PC Anywhere before beginning the Planning installation. The JVM will be 
installed along with the product. After you complete the Planning installation, reinstall PC 
Anywhere. 

• To use the Reference Application for Planning and the Reference Application Load and 
Upgrade Wizard, you must install the following versions of Hyperion software: Hyperion® 
Application Link 9.2 or 7.0, Planning Adapter 9.2, and Essbase Adapter 9.2. 

• Before you initialize the Reference Application, make sure that you register the 
application with Shared Services and that you are assigned the Administrator role in 
Business Rules.  

• When you uninstall Planning 9.2.1 for Windows, you can select the components you 
want to uninstall. When you uninstall this release for UNIX, all Planning files are 
automatically removed.  

• If there is a port conflict with the Web application server and if OracleHTTPServer is 
installed, the Planning Web client cannot start. Resolve the port conflict with the Web 
application server. For a list of port numbers used by Hyperion products, see the 
Hyperion System 9 Planning Installation Guide. 

• When you uninstall Planning on WebSphere 5.1, Planning is undeployed from 
WebSphere but port 8300 stays open. 

• On UNIX platforms, if you are using the IBM WebSphere application server, ensure that 
you use the same account to install, deploy, and execute Hyperion – System 9 products 
that you use to install WebSphere. Using the same account ensures that the Hyperion 
Configuration Utility can successfully deploy Hyperion products to WebSphere. 

• For earlier releases, when you upgrade Shared Services from 9.0.1 to 9.0.1.1 and 
Planning from 4.1.1 to 4.1.1.2, configuration does not function correctly. This is because 
recent Hyperion products do not include 9.0.0 in the file structure for the \config path, 
whereas earlier releases of Planning include 9.0.0 in the \config path. To work around 
this, remove the directory under <common>\config\product\planning, and copy the 
subdirectory under <common>\config\9.0.0\product\planning to 
<common>\config\product\planning. The shortcut in the Start menu is not available, 
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so you must restart the Hyperion Configuration Utility from 
<common>\config\configtool.bat. This issue does not apply to the current release. 

Support for Third-Party Products 

Planning 9.2.0.3 adds support for:  

• Internet Explorer 7.0 

• Windows Vista (Client) 

• AIX 5.2 ML7 

• AIX 5.3 ML3 

Planning 9.2.0.3 is the last release to support:  

• Firefox 1.0.7   

• Oracle Application Server 10G – 9.0.4 

• JDK Server 1.4.2_08  

• JRE Server 1.4.2_08  

• Browser Plug-in JVM 1.3.1_17  

In addition, Planning 9.2 no longer supports: 

• BEA WebLogic Application Server Version 7.0 

• IBM WebSphere 5.0.2.13 

Adapters for Loading Data and Metadata 

Oracle Data Integrator  
Oracle® Data Integrator Adapter for Planning enables you to connect and integrate Planning 
with any database through Oracle Data Integrator. The adapter provides a set of Oracle Data 
Integrator Knowledge Modules (KMs) for loading metadata and data into Planning applications.  

Hyperion Data Integration Management  
Hyperion® Data Integration Management (DIM) Adapter for Planning enables you to define 
target tables for loading data and metadata into Planning and use the target tables in workflow. 
You can load data and metadata into custom and attribute dimensions, and add UDAs to 
dimensions.  

Hyperion Application Link  
You can use Hyperion® Application Link Planning Adapter to load data values and other 
information from flat files or ODBC-compliant databases. You can also load data into Planning 
from an Enterprise Resource Planning (ERP) system. 

Note: Hyperion Application Link is not available to new customers for purchase. It is supported 
for customers who purchased it previously and are already using it.  

Top
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Known Issues 

This release of Planning has the following known issues. 

Audit Reports 

• An audit report does not show the names of the Calculate Currencies and the Calculate 
Form calc scripts when they are launched. Instead, the ID_1 column in the 
HSP_AUDIT_RECORDS table displays NULL instead of the name of the calc script.  

• Access assignments that are imported with the ImportSecurity utility are not reflected in 
the audit report.  

• If you have selected the Use Full Names option on the Application tab, and you select a user 
to report on as described in the “Reporting on Access Assignments” section by entering the 
user’s name instead of browsing to it, you must enter the user’s full name. If the user’s full 
name has a comma in it, you must enclose the user’s name in quotation marks (for 
example, "Hudd, Emily"). Likewise, if you enter a group to report on whose name has a 
comma in it, you must also enclose the group name in quotation marks (for example, 
"Sales, West"). 

Business Rules  

• On a Turkish operating system, if the Business Rules repository resides on a server whose 
host name contains the Turkish letter “ı” (without the dot), Planning cannot access the 
Business Rules repository. To work around this, install the Business Rules repository on a 
server whose host name does not contain the Turkish letter “ı” (without the dot). 

• If a hidden value has a function of level 0 in a business rule sequence, the validation of the 
business rule sequence fails in Planning. 

• Sometimes the default value of a variable of type real or percentage is altered when it is 
stored in Essbase. For example, a value of 0.141 may be stored and displayed as 
0.14100000262260437. 

• When selecting members for a business rule in Smart View, the list of members from which 
to choose displays alphabetically rather than by dimension hierarchy. 

• Performance is slow when exporting a group of business rules from Administration Services.  

• If you run a business rule having a runtime prompt that is based on a relationship function 
(for example, @IDESCENDANTS(Europe)) that results in a large number of members (for 
example, 5,000 or more), the business rule can fail if the generated calculation script 
exceeds the Essbase limit of 64K. 

• When you delete a business rule, you must also delete the rule from each Web data form 
that uses it. If you don’t delete the rule from the Web data forms, the rule is still listed on 
those forms but no longer functions. 

• A hidden local variable that isn’t used is displayed nonetheless when the business rule is 
executed from Planning. 

• When the “Use Member on Data Form" option is selected, the member displayed in the 
runtime prompt does not match the current member in the POV if the POV contains a user 
variable. Instead, the last successfully-used member selection displays.  

• If there are 10 or more business rules in a sequence, the index of the sequence is changed 
to an incorrect order. 
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• If Administration Services is deployed on an Oracle10g application server, imported 
business rules do not display line terminator characters when viewed in the Administration 
Console. This is a display issue only, and does not affect rule functionality. 

• If you add a user to an existing group, that user does not see in Planning Web the business 
rules to which the group is assigned access. To address this issue, restart the Planning 
server or, in the Administration Services console, delete and then add back the group from 
the Access Privileges for the business rules. 

• If you have a sequence with one or more business rules that contain hidden runtime 
prompts, you may not be able to launch the sequence. To work around this, do not hide the 
runtime prompts within the rules themselves; instead, hide the rule’s runtime prompts in 
the Launch Variables tab of the sequence. 

• If you use the function @LEVMBRS("Account", 0) in a runtime prompt variable for a rule 
that is designed against a Planning location, you may receive an error message when you 
try to save it, and no members will be available for selection when you launch the rule. To 
work around this, exclude hidden members in the Account dimension that are not visible in 
Planning member selection. For example, use the @Remove function: 
“@Remove(@Levmbrs("Account',0), @Idescendants(HSP_RateType))”. 

• When large numbers of concurrent users launch business rules, business rule launch errors 
might be displayed on the Planning server. To avoid this issue, turn off launch logging in 
the HBRServer.properties file. Open HBRServer.properties and comment out the 
HBR.launch_log parameters by adding a # character in front of each line:  

#HBR.launch_log.filename = hbrlaunch.log  

#HBR.launch_log.log_prompt_values = true 

#HBR.launch_log.log_calc_script = false 

#HBR.launch_log.date_format = yyyy/MM/dd:HH:mm:ss.SSS z 

• The Aggregate Data component does not function correctly when more than one account 
member is selected. For example, you can create a business rule using the component 
Aggregate Data, and then select the Account Members variable in the Account Member 
Selection window. If you then click Validate and select two account members, the rule is 
not validated and an error displays. 

Data Form Design 

• If one user edits a data form and then closes the window by clicking X, until that users logs 
out, the data form is locked if another user tries to edit it.  

• Cannot search for data forms using a data form name in the Select Data Form page. 
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External Authentication 

• Users or groups that are deprovisioned or deleted in Shared Services are not deleted from 
the Planning relational database. 

• When you indirectly provision for NTLM, LDAP, or MSAD, users are not added unless the 
provider is first in the search order among similar providers. For example, if multiple LDAP 
providers are defined in the CSS.XML file, indirect provisioning only works for the first LDAP 
provider in the search order. 

• You cannot add a user or group to Administration Services if their name contains a 
backslash ( \ ). 

• With the ImportSecurity utility, you cannot import security access for users who have 
double quote (“”) characters in their names.  

• If MSAD or LDAP users or groups are renamed in Planning, they are deleted from Planning 
during bulk synchronization. 

• Single-user synchronization fails if Planning is installed on UNIX and NTLM is used. 

• Users provisioned indirectly and retrieved using Hyperion Remote Authentication Module are 
not added to Planning during bulk synchronization. Users can be added to Planning if they 
are provisioned directly.  

• If you create security filters for a single user in Planning Desktop, a bulk synchronization 
might be performed for all users.   

• If you do not specify a domain element in the CSS.XML configuration file, a search for a user 
or group that is specified in multiple places returns only the first match. The match order is 
as follows: 

1. Local computer  

2. Domain of local computer  

3. Trusted domains 

For example, if both the local computer and the domain of the local computer have an 
Administrators group and the domain element of the NTLM server is not specified in the 
external authentication configuration file, all methods that search for the Administrators 
group return only one Administrators group. The returned group is the group on the local 
computer.  

Oracle recommends that you specify a domain element in the external authentication 
configuration file. If a user ID exists with one password in an NTLM repository and another 
password in another repository (LDAP or MSAD), and NTLM is earlier in the search order, 
authenticating the LDAP or MSAD user ID can result in a lock out of the NTLM user account. 
To address this situation, it is recommended that you use the provider hint while 
authenticating a user, if the authentication repository is known. 

• Users with empty passwords are not supported. 

• The single sign-on token carries the time that the token was created and times out based on 
the settings provided in the external authentication configuration file. Therefore, ensure that 
the system clock is set correctly.   
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• Microsoft Active Directory sp2 and earlier releases of Hyperion applications are known to 
have connectivity issues over SSL. To resolve such issues, refer to: 

http://support.microsoft.com/default.aspx?scid=kb;en-us;Q320711 

• If you are using Turkish Regional Settings, to set up external authentication, you must use 
the Cryptix JCE provider. Perform these steps: 

1.  Go to the following URL: 

 http://www.ntua.gr/cryptix/products/jce/ 

2.  Download the distribution package file and extract it to a temporary directory. Copy the 
following files from the bin directory where you extracted the files to the jre\lib\ext 
directory for the JDK of your Web application server. (For example, if you are using JRun 
or Apache Tomcat, this directory is: <drive letter>:\Hyperion\common\JDK\Sun\ 
1.3.1\jre\lib\ext.) 

cryptix-jce-api.jar 
cryptix-jce-compat.jar 
cryptix-jce-provider.jar 

3.  Register the security provider in the java.security file by doing one of the following. 
(By default, the java.security file is located in the jre\lib\security directory for the 
JDK of your Web application server. For example:<driveletter>:\Hyperion\common 
\JDK\Sun\1.3.1\jre\lib\security.) 

• If the java.security file is preconfigured with this line: 

security.provider.x=com.sun.crypto.provider.SunJCE 

Replace "com.sun.crypto.provider.SunJCE" with 
“cryptix.jce.provider.CryptixCrypto”  

• If the line “security.provider.x=com.sun.crypto.provider.SunJCE” does not 
exist, update the java.security file by adding this line: 

security.provider.x=cryptix.jce.provider.CryptixCrypto 

where x is the next available integer. 

• Earlier releases of Hyperion applications that employ Hyperion Remote Authentication 
Module 7.0 return an incorrect list of users and groups if the domain element is specified in 
the configuration file. To avoid this situation, use only Hyperion Remote Authentication 
Module 7.2 with Planning 9.2. For earlier releases of Planning, continue to use the earlier 
Remote Authentication Module (previously called NTLM Remote Server). 

• When using the ProvisionUsers utility, ignore the FileNotFoundException messages in 
the UserProvisionSync.log file such as this example: java.io.FileNotFoundException: 
C:\Hyperion\HyperionPlanning\config\security.properties (The system cannot 
find the path specified). 

• Hyperion Remote Authentication Module 9.0.x does not support SSL connections on AIX.  
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Localized Versions of Planning 

• Some product installers display an incorrect translation of the Cancel button.  

• On UNIX platforms, if you run an installer in graphical mode and see square blocks on the 
interface, run the installer in console mode. This problem occurs on Linux, AIX, and HP-UX 
for these locales: Japanese, Korean, Simplified Chinese, and Traditional Chinese.  

• The Hyperion Home Migration Utility does not read the Hyperion Home environment variable 
even though it is already set. To migrate again, first open and close a command window 
before starting migration a second time. This ensures that the most recent Hyperion Home 
environment variable is displayed. This problem occurs only in these languages: Dutch, 
Simplified Chinese, Traditional Chinese, Korean, and Russian.  

• Hyperion® Shared Services User Management Console does not open when launched from 
the Windows Start menu shortcut (Windows XP, Korean operating system, WebSphere 
5.1.1.7 only). Use the URL http://localhost:58080/interop/index.jsp to launch the 
console instead of using the Start menu.  

• Using a Portuguese operating system, the drop-down list on the Language Selection panel in 
the installer incorrectly displays Simplified Chinese, Traditional Chinese, and Portuguese 
selections in Portuguese characters. All other language selections are displayed in English. 

• Using a Turkish Linux operating system, several languages on the Language Selection panel 
in the installer are incorrectly displayed in English instead of Turkish. 

• Because of a known issue with WebLogic 8.1 using a Turkish operating system, Hyperion 
products cannot be deployed to WebLogic 8.1 in a Turkish operating system environment. 
You must switch the locale to English and then deploy the product. 

• In product installers and the Hyperion Configuration Utility, hostnames (computer names) 
should not be localized and should be entered in English only. For example, when 
registering with Shared Services in the Hyperion Configuration Utility, the Shared Services 
server name should be entered in English.  

• On the Shared Services registration/deregistration panel in the Hyperion Configuration 
Utility, using a Turkish keyboard to enter an IP address in the Server text box does not 
work properly. You must specify the host name rather than the IP address in the Server text 
box. 

• On AIX 5.2 with an Italian locale, the drop-down list on the Language Selection panel in the 
installer is displayed behind the display window.  

• Using a Russian operating system, the OK button on the Language Selection panel in the 
installer is displayed in English rather than Russian.  

• Using a Russian keyboard to press keyboard shortcuts in the installers and Hyperion 
Configuration Utility does not work.  

• Using a Russian operating system or a Simplified Chinese operating system on HP-UX 
Itanium, incorrect Russian characters are displayed when running the Hyperion 
Configuration Utility, the Hyperion Home Migration Utility, or the Hyperion License Server 
installer in console mode.  
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• In Korean, if you configure Planning to deploy WebLogic 8.1.4 as a service, a “Servlet 
compilation” error is displayed when you try to log on to Planning Web. To work around 
this: 

1. Add <drive_letter>:\bea\jrockit81sp4_142_05\bin to the system PATH. 

2. In the installSvc.cmd file in the <drive_letter>:\bea\weblogic81\server\bin 
directory, append:  

-Dcom.sun.tools.javac.main.largebranch=true 

to the existing set of JAVA_OPTIONS of the CMDLINE string. For example: 

set CMDLINE="%JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% -classpath 
\"%CLASSPATH%\" -Dweblogic.Name=%SERVER_NAME% -
Dweblogic.management.username=%WLS_USER% -
Dweblogic.ProductionModeEnabled=%PRODUCTION_MODE% -
Djava.security.policy=\"%WL_HOME%\server\lib\weblogic.policy\" -
Dcom.sun.tools.javac.main.largebranch=true weblogic.Server" 

• With the locale set to Turkish, you cannot start any server (even the default server). This 
prevents Planning from deploying. To work around this, avoid setting the locale to Turkish. 

• In Turkish, you cannot log on to Planning if the application name contains the characters 
lowercase i-dotless and capital I-dotted. 

• In Turkish, you cannot create a Planning application for DB2.  

• If you are using a Korean operating system with Oracle as the relational database, Oracle 
recommends that you use the Oracle thin driver.  

• If the application name contains the character Mu, you cannot open the application on the 
Web. 

• When the operating system language does not match the Planning language and Planning is 
running as a Windows Service, Planning determines the locale setting from the Log On As 
user that launches these processes as services. For example, Hyperion Reports Report 
Server and Hyperion Reports Web Application Server are both started as services and 
interact with the Planning ADM driver. The Planning ADM driver launches Planning in the 
same locale setting as the Reports services. So the Log On As user needs to be in the 
correct locale (such as Thai) when the operating system is in a different locale (for example, 
English). 

To avoid problems, set up the service for the user currently logged on. From the Windows 
Start menu, select Programs > Administrative Tools > Services. Then select the Planning 
Service and the LogOn tab. Select This Account and browse to the user that’s currently 
logged on to the system (not the Local System user). 

• In Japanese, if you use more than 80 characters for a dimension member’s name, an 
incorrect error message is displayed. To work around this, use 80 or fewer characters for 
dimension names.  

• On a system that uses Japanese or other double-byte characters, on the Printing Options 
dialog box, for the Font drop-down list, you must select Default or a font that you specified 
in your properties file; otherwise member names that use double-byte characters are not 
displayed in the PDF file. For information about setting up fonts, see the Hyperion System 9 
Planning Administrator’s Guide.  

• If you are using DB2 relational database software with Planning, do not override the 
localized numeric format. For example, do not override the French comma decimal point 
separator with a period. Overriding the localized numeric format might cause queries to fail. 
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• The limitations noted for member names, descriptions, annotations, and so on in the 
Hyperion System 9 Planning Administrator’s Guide and the Hyperion System 9 Planning 
User’s Guide indicate the number of bytes for each item. So for example, a limit of 255 
characters for the Description is actually a limit of 255 bytes, and a limit of 1500 characters 
for a planning unit annotation is actually a limit of 1500 bytes. In languages with multibyte 
character sets, a character is more than a byte, so you reach the limit with fewer 
characters. If the string exceeds the byte count, you see an SQL error on the server side.  

• The details of member formula validation are not localized. 

• On multibyte systems, Oracle recommends not entering planning unit annotations of more 
than 750 characters. 

Logging On 

• Planning does not support non-ASCII characters for passwords. For example, users cannot 
log on if a password contains Japanese characters. 

Menus 

• When you access a Hyperion® Workspace report using a Planning URL menu item, you 
cannot export the report to Excel or print the report in PDF format.  

• When using Planning from a Firefox browser, the Member Properties page does not display 
correctly. 

• Planning menu items are sometimes resequenced. 

Planning Desktop 

• To unregister an application, on Planning Web, select Administration > Application Settings, 
and select Unregister Shared Services. 

• If you add years or currencies to the application using Planning Web while the application is 
open on Planning Desktop, the added years or currency are not displayed in the Exchange 
Rate table. To display the added years or currencies in the Exchange Rate table, you must 
either refresh the database or reopen the application.  

• Before opening an application on the Planning Desktop, selecting Edit > User Options and 
then clicking Help results in an error message. There is no Help available for this dialog box.  

• For information on using the new System Properties and Data Source options on the 
Planning Desktop, follow the instructions in the Hyperion System 9 Planning Installation 
Guide. There is no online help for these new features. 

Desktop Help Files on Windows Vista 
Windows Vista does not include support for Windows Help (.hlp files using the 
WinHlp32.exe file). These Planning Desktop help files are distributed in Windows Help 
format: 

• Desktop Help, desktop.hlp 

• Hyperion Planning Desktop Help, hphelp.hlp 
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If you plan to install these files on a Windows Vista computer, you can follow the 
instructions in the article from the Microsoft Knowledge Base entitled: “The Windows Help 
(WinHlp32.exe) program is no longer included with Windows operating systems starting 
with Windows Vista.” The article can currently be found at: 
http://support.microsoft.com/kb/917607/en-us. The instructions on the Microsoft page 
allow you to enable limited support for files in the Windows Help format.  

Oracle neither recommends nor opposes the solution from Microsoft. You should carefully 
evaluate the Microsoft solution and determine if it is appropriate for your site. 

The Planning Desktop information is also included in the hp_desktop_admin.pdf file located 
in the docs folder on the Hyperion Planning CD.  

Relational Databases 

• Planning requires CURSOR_SHARING in Oracle to be set to “EXACT”. This is the default setting. 
If you have performance issues with Planning Cube refresh from the Desktop, ensure that 
this setting to is set to “EXACT”. 

• Planning applications using an Oracle database require specification of a localized non-UTF8 
character set in Oracle. 

• For Oracle 9i with Windows Server 2000, if the database has a replication partition, a full or 
partial refresh does not complete and this error message might display in the Planning 
Desktop: "Restructuring database <dbname> step 26 of 27.” To work around this, 
remove the partition during refresh, and add the partition back again after completing the 
refresh. 

• If you are using DB2 8.1 relational database software and the Hyperion JDBC driver with 
Planning, you might get the error, "Virtual storage or database resource is not available" in 
your Web application server log. Try increasing the heap size database parameters to: 

APP_CTL_HEAP 512  
APPLHEAPSZ  4096   

Another alternative is to use the IBM JDBC driver.  

• Microsoft OLE DB provider for Oracle does not support ONAMES (only TNSNAMES or 
HOSTNAMES service name resolution methods for Oracle are supported). If you are using 
Oracle and try to use ONAMES, you will receive error number 2147160060 and will not be 
able to create an application. 

• For applications running on Oracle or DB2 relational databases, it is possible to create data 
forms and user groups that have the same name. Oracle recommends that you do not 
create data forms and groups with the same name. If data forms or groups with the same 
name exist in an application, you should rename them with unique names before you 
upgrade to the most recent version of Planning. You should also change data form names 
that have the same name in different case (uppercase versus lowercase) before upgrading 
to Planning on Oracle or DB2. Using unique names can provide better performance with 
data forms on the Web. 

http://support.microsoft.com/kb/917607/en-us
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• On Oracle databases, if two users save supporting detail at the same time when clustering 
over several Web application servers, one user may get an error message. If this happens, 
the user should resubmit the supporting detail. If this situation happens often and you do 
not need to run in a cluster for performance reasons, you could use a single server. This 
error can happen only in clustered mode. 

• Setting the maximum SQL connection to 1 in the HspJSHome.properties file causes 
problems in Planning. If you set the maximum SQL connection to 1, you cannot start a 
planning unit, and once you try to start a planning unit, you cannot read from SQL any 
more. 

Shared Services 

• All documentation for new features, enhancements, and fixed defects for System 9 security 
and user provisioning is contained in the Hyperion System 9 Shared Services 
Documentation Addendum. This document is provided with the Shared Services Installation 
Documentation zip file on Hyperion Download Center and on the Shared Services DVD. 

• When using Hyperion Configuration Utility to configure a database, for the database name, 
you can enter only English alphanumeric characters and the dash character (-). 

• If you register an application that is under Unassigned Project, you get an error message on 
the Planning server log, even though the application is successfully registered.  

• If SSL is enabled, sometimes you cannot log on to Planning from the Shared Services User 
Management Console and instead get a timeout error. To work around this, change the 
Shared Services Cookie Name from “HUBSESSIONID” to “JSESSIONID”. For example, to 
manually change the Cookie Name from the WebSphere Console, select Application Server 
> SharedServices9 > Web Container > Session Management > Enable Cookie, and specify: 
Cookie name = JSESSIONID. 

• If you add a user in Shared Services whose name is 40 characters long and provision the 
user for Planning, when you update the user list in Planning by clicking the Refresh Users 
and Groups button, this message displays: “Sync with user provisioning succeeded with 
errors.” This error does not occur if the user’s name is fewer than 40 characters. 

• Registering a Planning application in Shared Services fails when Siteminder is enabled for 
both Planning and Shared Services. 

• When you register Administration Services and Planning with Shared Services at the same 
time, the HBRServer.properties file is not uploaded to Shared Services. To work around 
this: 

1. Register Essbase Administration Services with Shared Services, selecting these two 
options: Relational Storage Configuration and Shared Services Registration. 

Optional: You can select the Application Server Deployment option now or later. 

2. Register Planning with Shared Services. 
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• Under the following conditions, you must log on to a Planning application twice to be able to 
access all the Shared Services menu items from within Planning: 

1.  You log on to a Planning application as the owner of the application.  

As appropriate (because you have not yet registered the application with Shared 
Services and assigned it to a Shared Services project), the following Shared Services 
menu items are not yet accessible from Planning’s Administration menu: Manage 
Models, Manage Projects, Manage Data, and Scheduled Integrations.  

2.  Without logging off the Planning application, you log on to Shared Services as 
administrator and provision your user name for the current application with the Manage 
Models role and provision your user name with Create Integrations and Run Integrations 
roles under Shared Services’ Global Roles.  

3.  In Planning, you synchronize the users and groups in Planning with the Shared Services 
User Management console by clicking the Refresh Users and Groups button. For more 
information, see the Planning appendix in the Hyperion System 9 Shared Services User 
Management Guide. 

4.  To display all four Shared Services menu items on the Administration menu in Planning, 
log out of the Planning application and then log on again.  

Design Considerations for Planning and Shared Services  

The following topics describe information to consider when using Planning and Shared Services.  

General Considerations 
The following considerations apply to use of Shared Services: 

• You cannot successfully update a provisioned group from the Shared Services User 
Management Console to Planning if a user in the group includes users from a domain that is 
not trusted.  

• If Shared Services is installed on a different machine from Planning, access might be denied 
for Manage Models, Scheduled Integrations, or Manage Data menu items. For example, you 
might install Planning and Shared Services on different machines, register the Planning 
application, and then export all dimensions from Planning to Shared Services. If you use 
Manage Data to create integrations, you might not be able to switch to Scheduled 
integrations or Manage Models, and an Access Denied error message could be displayed. To 
work around this, click the Refresh button to refresh the page.  

When creating data integrations, all dimensions of a Planning application regardless of valid 
plan type are displayed in the Shared Dimensions page. For dimensions not valid for the 
plan type selected in the Data Source drop-down list, you can leave the member selection 
box empty. 

The Local member for the Planning Currencies dimension does not display in the Currencies 
model in Shared Services. To copy data to the local currency in a Planning application, you 
must type the member "Local" in the member selection box in the data integration. The 
following are examples of data transfers to a Planning application: 



Hyperion Planning – System 9 Release 9.2.1 Readme 

21 

• When you copy data between Planning applications, the data values along with the currency 
tags are copied. This ensures that the data copied is expressed in the appropriate currency. 
If you copy from a reporting currency to Local, in some cases, this may result in currency 
overrides if the entity base currency in the destination cells is different than the reporting 
currency from the source cells. Any cells whose currency does not match the reporting 
currency are not copied but are ignored (for example, if you copy from Local to EUR 
reporting currency, any data values in the Source application that do not have a EUR tag, 
either implied by the entity’s base currency or explicitly through a currency override, will 
not be copied to the Destination application). 

• Currently Planning and Hyperion® Business Modeling transfer data values with currency tags 
so it is possible to directly transfer data between these two products in the appropriate 
currency. However, currency tags do not exist for Hyperion® Financial Management – 
System 9 so for data transfers between Planning and Financial Management, you need to 
specify the currency in the integration in both the source and destination (for example, 
copying actuals from Financial Management to Planning or copying budget from Planning to 
Financial Management). If you have a need to copy data from Financial Management to 
Local in Planning, you need to first copy the data to a reporting currency in Planning and 
then create another integration that copies the transferred data to Local within the Planning 
application (see the first bullet above). 

Optimizing Data Integrations for Planning 
Oracle recommends that you plan your data integration before you create it. This section 
describes how to develop such a plan, and the following section provides an example. 

Note: The term shared dimension in this topic refers to a dimension that is shared for a 
particular data integration, not a dimension shared for the purpose of metadata sharing.  

The order in which you share dimensions is critical to performance. To optimize performance, 
follow these guidelines: 

If you are selecting only one member from a dimension, do not share it. 

The order of the dimensions in an integration is based on the order that you share them. Share 
the dimensions in this order: 

• Share all sparse dimensions before sharing the dense dimensions. 

• Within the sparse and dense dimensions, order the dimensions by the number of 
members selected for them. For example, the dimension having the smallest number of 
members selected is shared first, and the dimension having the largest number of 
members selected is shared last. 

Note: Order the dimensions by the number of members selected for this integration, not by the 
total size of the dimension. 

Before sharing dimensions in the correct order, you may need to click Unshare All on the 
second page of the data integration wizard to remove sharing from all dimensions. 



Hyperion Planning – System 9 Release 9.2.1 Readme 

22 

If you have four or more shared dimensions, of which at least one is sparse, you can improve 
performance by selecting the largest eligible shared sparse dimension and moving it from the 
background POV to the dynamic POV. A dimension is eligible to be moved to the dynamic POV if 
the following conditions are met: 

• The dimension is sparse. 

• No other dimensions exist in the dynamic POV. 

• The members in the dimension are selected explicitly (not by function). 

Note: If the dimension has a large number of members and must be updated often, it is not a 
good candidate for a dynamic POV (because each member must be placed in a separate 
dynamic POV entry). 

Example of Optimizing Data Integrations 
In this example, which illustrates the guidelines in the preceding section, the dimensions are 
shared in the following order:  

1. First, they are shared according to their density (sparse before dense). 

2. Second, they are shared according to the number of members selected (least before 
most). 

3. Next, all dimensions with one member selected are assigned to the POV. 

Because there are four or more remaining shared dimensions after the first three are moved to 
the POV, Year is moved to the dynamic POV, because it meets the conditions specified in the 
previous section. 

Dimensions should be shared in the integration in the order in which they are listed in the 
following table: 

Dimension Density Number of 
Members 
Selected 

Example Member 
Selection 

Location 

Scenario Sparse 1 Budget POV 

Version Sparse 1 First Pass POV 

Currency Sparse 1 Local POV 

Year Sparse 3 FY02, FY03, FY04 Dynamic POV 

Entity Sparse 2000 BottomOfHierarchy() Shared 

Period Dense 17 IDescendants(YearTotal) Shared 

Account Dense 2000 BottomOfHierarchy() Shared 
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Resulting Integration 

POV: Scenario: Budget, Version: First Pass, Currency: Local 

Shared 1: Entity: BottomOfHierarchy() 

Shared 2: Period: IDescendants(YearTotal)  

Shared 3: Account: BottomOfHierarchy() 

Dynamic POV: Year: FY02, FY03, FY04 

Managing Models 
The following considerations may impact the managing of models. 

Adding Dimension Members in Shared Services 

In Shared Services, if you add a sibling of a member, the new sibling inherits the properties of 
the member selected and not from the parent as is the case in Planning. 

In Shared Services, if you add a child or sibling of a selected member that has attribute values 
assigned, the new member inherits these values. When adding a child, this results in attribute 
values being assigned to members at different levels. Because same attribute values cannot be 
assigned at different levels in Hyperion® Essbase – System 9, import issues result. Although the 
actual import completes, an error occurs when refreshing the database in Planning. 

Although children can be added to flat dimensions (for example, Scenario, Version, and 
Currency dimensions) in Shared Services, these hierarchal members are ignored when imported 
to Planning. 

Attribute Dimensions 

For Planning, attribute dimensions behave differently than true dimensions. If a user is 
importing to a Planning application a custom dimension model that has an attribute dimension 
associated with it from Shared Services, specific steps must be performed to successfully 
import the dimension model: 

1. Manually create the corresponding attribute dimension in the Planning application (creating 
the "container" first is the same requirement as for a true dimension model). 

2. Import the attribute members (attribute dimension model). 

3. Import the custom dimension model. 

When importing dimension members referencing attribute members that do not exist in the 
receiving Planning application, only the members themselves are imported; the attribute values 
are ignored (disassociated from the members). 
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A recommended practice if seeding one Planning application from another Planning application 
from scratch is to select all dimension models in Shared Services, then run the import. This 
ensures that all dimension members and their associated attribute members or values are 
imported successfully. 

Although children can be added to attribute members in an Attribute dimension (non-level 0 
support) in Shared Services, these children are ignored when imported to Planning. 

Importing Members   

Before you import members into Planning, the root dimension must exist in the Planning 
application. 

When importing an account member that has an invalid Plan Type as its account source to 
Planning from Shared Services, the account source is set to the first valid Planning Plan Type 
for this account. This behavior is similar to that of the Planning Adapter (see other Plan Type 
considerations in “General Considerations” above.) 

When importing to Planning from Shared Services, version types are checked for validity in 
Planning. Currently, Planning does not support Target versions in Workflow so any Target 
version members who have process management enabled in Shared Services are not imported 
to Planning. Since changes to a version type may have an impact on planning units in Planning 
Workflow, a version whose type is changed from Bottom Up to Target in Shared Services and 
has planning units started in Planning, errors out upon import. 

When importing to Planning from Shared Services, changes to 4-4-5 distributions on specific 
account members are applied only if the Planning application has the 4-4-5 distributions 
enabled at the application level. If not, any 4-4-5 distribution assignment is ignored upon 
import. 

In Shared Services, because it is possible to add duplicate member names, importing the 
duplicate member to Planning may unintentionally result in the original member being replaced 
with the duplicate member (similar to the behavior using the Planning Adapter). Oracle 
recommends using the validation feature in Shared Services to identify duplicate names to 
minimize such accidental overrides. 

“Marked for Delete” Members 

Planning supports Marked for Delete functionality. This functionality provides the ability for 
Planning to system-generate a tag/mark to an existing dimension member, within the Planning 
application, to indicate a “pending delete” state during a dimension import from Shared 
Services, without actually deleting the member from the Planning outline. This mark remains 
until the user deletes or un-marks the member. Members marked for deletion include those 
members that exist within the target file (Planning), and are missing in the source file (Shared 
Services). These marked members still display in the outline (editable) and are available for 
data entry form design and workflow as valid members. The following rules also apply: 

• Export to Shared Services - Any Planning dimension that includes members that are 
marked for deletion is “locked” and prohibited from being exported to Shared Services. 
This “locked” state remains until all marked dimension members in a particular 
dimension are physically deleted from the application or restored to the original non-
marked state. 
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• Import from Shared Services – Any Planning dimension that includes members that are 
marked for deletion is “locked” to prohibit subsequent metadata loads to that dimension. 
This “locked” state remains until all marked dimension members in a particular 
dimension are physically deleted from the application or restored to the original non-
marked state. 

Shared Members 

If a description for a base member is changed in Shared Services, the descriptions of shared 
members remain unchanged because of Shared Services functionality that allows a shared 
member description to be modified manually and be unique to its base member. Currently, 
Planning does not support this behavior for shared member descriptions. In Planning, the 
description of shared members is modified to match the base member whenever the shared 
member is saved, and cannot be modified manually by typing in the text field. Therefore, 
whenever a dimension Model is imported into Planning, the description of a shared member is 
modified to match the base member, regardless of any changes to the shared member 
description made within Shared Services. 

Skip Option Value 

When using Shared Services, Skip Option values are occasionally reset when you import 
Accounts dimension members whose Time Balance property is set to Flow. However this is not 
a problem because Planning ignores the Skip Option value when the Time Balance is set to 
Flow. 

In Shared Services, it is possible to select any Skip Option value for an account whose Time 
Balance type is set to Flow. However, when importing to Planning, if the setting is set to 
Missing, Zeros, or Missing and Zeros, the setting is ignored and set effectively to None (to 
comply with the default setting in Planning). 

Year and Period Dimensions   

Although the Year and Period dimensions have the same editing UI behavior in Shared Services 
as other dimension models, only member updates (add/modify/delete) to associated aliases 
and descriptions are supported when importing to Planning. Any Year or Period members added 
or deleted in Shared Services are not allowed to be imported to Planning. 

Web Clients 

• Before a Planning refresh, a new Planning user can access any member using the Essbase 
Add-in. 

• Administrators can enter data at the top level (generation 1) of the Version dimension. 

• When you right-click to open a menu in a data form, you must click directly on the 
dimension member name displayed for the row heading. Otherwise, the menu does not 
open. 

• On the Manage Models page, an error is displayed if you select Administration > Manage 
Models > Manage Data. To avoid this situation, first click the Close button on the Manage 
Models page to return to Planning, and then select Administration > Manage Data. 
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• With Planning, you cannot use the Essbase dynamic time series Y-T-D (year-to-date) or  
P-T-D (period-to-date). This is because two default Planning dimensions, Year and Period, 
have the same name as members used in the dynamic time series. To work around this, 
perform one of these actions:  

• In Planning Web, modify the names of the Year and Period dimension.  

• Use a different dynamic time series member, such as S-T-D (season to date), instead of 
Y-T-D or P-T-D. 

• When working with member formulas, if you create a custom macro, an error message is 
displayed in Planning and the Essbase Console when the member formula is validated. If 
you restart the Essbase server and reload the applications, the Essbase Console confirms 
the member formula validation. The error message still displays in Planning. 

• With Solaris, when you log on to Planning, you might see an error message about 
connection pooling. To work around this, set the LANG environment variable to the following: 

SOLARIS: LANG=iso_8859_1 
AIX: LANG=en_US.ISO8859-1 
HP-UX: LANG=en_US.ISO-88591 

Note: If the desired language is not English, en_US should be replaced by the desired 
language and country code combinations. For example, if you are using German on HP-UX, 
the correct setting for LANG is: de_DE.ISO-8859-1 

• When you work with member formulas, you see a status message after validation. This 
message is displayed even when member formulas are successfully validated. The message 
either confirms the validation or displays any errors encountered. 

• For UNIX, if you are using an extended character set for Web Planning, you must set the 
environment where the Web application server is running to the proper locale. For example, 
if you are using European Latin characters in your Planning application, set the UNIX 
environment variable to LANG=iso_8859_1. 

• You cannot use the Copy Data feature with attributes, so do not select attributes to be 
copied. 

• For Copy Data to be successful, when specifying copy data criteria, you must select at least 
one member for the Scenario, Account, Entity, Period and Version dimensions. 

• Copying and pasting data from a text editor (for example, TextPad, NotePad, or WordPad) 
fails if the data is space delimited. Use Tab-delimited values instead. 

• The first person to use Planning Web after an Essbase timeout may receive an error 
message that the data form failed to open. The user needs to click Refresh to restore the 
connection between Planning and Essbase. 

• If a dense dimension member on a row does not exist in Essbase, the data entry page does 
not display properly, but an error message might not be displayed. For example, you can 
create a data form with an account on the row, and then select the member and add 
children to the account. If you do not refresh the information, and then open a data form, 
the data form does not display properly and an error might not be displayed. 
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Other Known Issues 

• With the ImportSecurity utility, you cannot import access permissions for users who have 
double quote (“”) characters in their names. 

• When using the Member Properties window to delete a user-defined attribute (UDA) from a 
dimension, the alias for the selected member is also deleted. 

• In Planning reports, double-byte characters display as question marks. 

• For some large applications with custom dimensions that have more than 20,000 members, 
incremental refresh is not successful. 

• When you use Financial Reports to create Planning data source reports with more than 
64,000 possible rows, the server becomes non-responsive. To work around this, your can 
move one of the selections from rows to the Page. For example, if you decrease the possible 
row count to 27,000 by moving rows to the Page, the report runs successfully. 

• HspDSincorrectly uses Essbase API for memory management. 

• Planning is not accessible on WebLogic’s SSL port. With 
\Hyperion\common\CLS\9.3.0\lib\EccpressoAll.jar in the java.class.path, there is a 
conflict with the Eccspresso .jar files shipped with BEA WebLogic, due to a conflict between 
Eccpresso classes and HTTPS. 

• On UNIX platforms, Application Server Deployment or Web Server Configuration tasks may 
fail if the temporary directory (as defined by the TEMP environment variable) contains  
*-build.xml files created by another user. Ensure that *-build.xml files do not exist in the 
temporary directory before running Configuration Utility.  

• In the English release of Planning, you cannot create reports in Asian, Russian, or Turkish 
fonts unless the fonts are specified in the Planning properties file on the applications server. 
To enable printing in other languages, update the Planning properties file with true type 
fonts from the \\winnt\fonts directory. Use Times New Roman for Russian, and Courier for 
Turkish. Open the Planning properties file (HspJSHome.properties) and add an entry using 
this syntax: PDF_FONT_FILE=path\\font1,path\\font2,path\\font3  

Use double backslashes in the path name, and separate font names with commas, for 
example: PDF_FONT_FILE=c:\\winnt\\fonts\\comic.ttf, 
c:\\winnt\\fonts\\msmincho.ttc. After you save and close the properties file, fonts are 
available for applications using this server.  

• On the Planning Desktop, you cannot delete an application that is registered with Shared 
Services. If you try, the following error message is displayed: "Failed to Delete 
Application:<name of application>. Application is registered in Hub. Please Unregister it in 
Hub first." The error message should refer to Shared Services, not Hub. 

• When using the Data Load page, the driver dimension members are not displayed after you 
select the data load dimension and click Go. You must select both a Driver and Data Load 
dimension to view the Data Load dimension members. 
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• After you install Planning, Hyperion Application Link, Essbase Adapter, and the Planning 
Adapter, you may encounter the following error message when you run 
RefAppUpgradeUtility.exe to load or upgrade the Reference Application: 
java.lang.UnsatisfiedLinkError: no HssJNIDriver901 in java.library.path. 

To correct this error: 

1. Open the Windows Control Panel > System > Advanced > Environment 
Variables. 

2. In the User Variables section, check that this user PATH exists: 
<HALInstallDir>\Hyperion\EssbaseAdapter\ADM 

3. If it exists, click OK. 

4. If the path doesn’t exist, enter it and click OK. 

5. Close the Control Panel. 

6. Rerun the Reference Application Upgrade utility, RefAppUpgradeUtility.exe. 

• If your application contains accounts with Time Balance set to “Weighted Average - 
Actual_Actual” or “Weighted Average – Actual_365”, in Planning, assign the HSP_LeapYear 
UDA to Year members that are leap years (for example, FY08) and assign the HSP_UDF 
UDA to summary time periods (for example, YearTotal, Q1 and so on) before you refresh 
the database. (Alternately, you can copy member formulas from the Administration 
Services console outline and save them in Planning.) 

• When you select File > Return to Application from within the User Management Console, 
you may receive an error message. To return to the Planning application, click OK at the 
message. 

To prevent the display of this error message when you select Return to Application from 
within the User Management Console, do the following: 

1. From the Microsoft Internet Explorer menu bar, select Tools > Internet Options. 

2. Select the Advanced tab. 

3. In the Browsing section, clear the following check box: Display a notification about 
every script error. 

4. Click OK. 

• The administrator may get an error message and be unable to refresh an application 
because multiple users are logged onto the system. This error occurs when the user who 
logged on last closes the Web browser without logging off the application. To work around 
the error, select the “Lock selected application from other users” check box in the Manage 
Database window, and then open the Planning Web Logon page (but do not log on) before 
refreshing the application. 
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• When you try to delete an entity that is associated with a planning unit, you are prompted 
with a message that asks you to confirm the deletion of the entity and its associated 
planning unit. (At this point, a failed deletion message is written to the Web application 
server log.) If you answer Yes to the deletion prompt, the deletion is successful even though 
the Web application server log states the deletion was unsuccessful. 

• If an application has many periods (for example, 500) that are included in a currency 
conversion calc script, the conversion calc script you are trying to create could exceed the 
64K limit. If this occurs, try giving the periods very short names.  

• If you make a change on the Dimensions tab that affects the Essbase database, and then 
try to open a data form that contains the changed dimension, the data form might not open 
properly; in some cases you do not receive an error message from Essbase. To work around 
this situation, refresh the Essbase database. If the cache contains a copy of the data form 
definition, you might need to open a different data form and then re-open the data form on 
which you were working. 

• To access Planning Desktop help, you must first open the Planning Desktop application. 
Select Help > Contents to access help for the Planning Desktop. 

• If you are using Windows 2003 Server Standard Edition and Enhanced Security is enabled in 
your browser, the Logon page does not display correctly. To work around this, add the site 
to the list of trusted sites for your browser. 

Top

Defects Fixed in this Release 

• Planning reports fail when run on a Solaris system.  

• If a user is in both an external authentication group and a native group, and a business rule 
has access set for the external group only, the user cannot view that business rule. Also, 
the user is listed twice in the Rules access list in Administration Services. 

• Entries in the Planning system database must be in the correct case. Otherwise, Planning on 
UNIX does not resolve entries successfully. When you try to log on to Planning on UNIX, the 
Logon page displays “ No applications available” and you cannot log on.  

• The process for changing access permissions in Business Rules should be similar to the 
Planning process for changing access permissions. 

• Business Rules are not available in Smart View to users whose access to the rules is 
assigned indirectly.  

• Sometimes performance is slow when listing users or groups in Planning.  

• The database execution field in Sequences - Variables does not migrate to the destination 
server. 

• Because users are cached in Shared Services instead of Planning, accessing users may take 
longer than in earlier releases.  

• When deleting members, an error message displays, even if the deletion is successful.  
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• Several issues with using the Firefox browser were fixed.  

• When using Planning from a Firefox Web browser, the Help, Save, and Cancel buttons 
overlap on the screen if you add more than thirty-four entries to a Smart List.  

• Uninstalling Planning does not remove files in the temp directory for the Web application 
server.  

• When using Planning from a Firefox Web browser, shortcut menus are not available.  

• Creating the HspJSHome.properties file fails if SSL is enabled for Shared Services.  

• When using Planning with the Web browser Firefox, after you open a data form using Enter 
Data, you cannot resize the view pane or any data form cell.  

• Business Rules Saved Selections may not be migrated successfully.  

• When using the Firefox browser 2.0.3, Planning menu items do not display.  

• The message “No business rules are currently executing” displays when a user selects  
Tools > Job Status in Web Planning even if one or more business rules are running.  

• When the Business Rules connection to the relational database is lost, Business Rules does 
not automatically reconnect to the database. 

• Selecting Two Pass Calc for a parent time period member assigned the Dynamic Calc 
storage property results in an error. 

• In the Japanese version of Planning, when you select “About Hyperion Planning” the 
information displayed is translated incorrectly. 

• Cannot access Hyperion Business Rules through a Web-based Administration Services 
console. 

• Removing an application from maintenance mode in a load-balanced environment changes 
the application URL. 

• In a clustered environment, new menus added by selecting Administration > Manage Menus 
are not updated. 

• MSAD group provisioning only works for users that belong to the same provider as the 
group. 

• Data forms that contain German-accented characters fail to open if the Suppress Missing 
Blocks option is selected. 

• Logging into Web Planning is slow when many groups or users are in Shared Services.  

• Metadata loads between Essbase and Planning fail for accounts that use Shared Services.  

Defects Fixed in Planning Release 9.2.0.3 

• The children of HSP_Rates are not selectable fields in Business Rules for Planning applications. 

• The vertical scrollbar is missing when accessing dimensions from Shared Services. 
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• When deleting members, an error message displays, even if the deletion is successful. 

• Cannot assign UDAs for members of dense dimensions. 

• When promoting workflow, in certain configurations, the planning unit owner is not changed on 
all Web servers. 

You can configure the time interval after which changes are deleted from the HSP_Action 
table. 

For each Web server, locate and modify the HspJSHome.properties file to add these 
entries and a value in milliseconds (one thousandth of a second):  

a. POLLING_INTERVAL, for example, POLLING_INTERVAL=1500. This represents the interval 
for the Planning server to synchronize events on other servers. The default value is 10000 
(10 seconds).  

b. EXPIRED_INTERVAL, for example, EXPIRED_INTERVAL=140000. This represents the interval 
for servers to synchronize events before they expire. The default value is 60000 (60 
seconds). If the servers are still not synchronized at the specified value, try increasing the 
value.  

The actual value of the event expiration interval (in seconds) is calculated as: 
((EXPIRED_INTERVAL/1000 + (POLLING_INTERVAL*3/1000) + 10)  

Be sure that all Web servers have the same settings in their corresponding 
HspJSHome.properties files. 

• Changing column order in a data form without saving data beforehand results in one merged 
column. 

• Access permissions are not enforced at the folder level, allowing interactive users to delete 
folders of data forms, rather than just the data forms they created or to which they have 
access. 

• Some supporting detail displays as duplicate rows. 

• When copying supporting detail on the Copy Data page, if the cell text or annotations options 
are selected and the number of dimension members exceeds 1,000, error ORA-01795 can 
occur.  

• If the Year Total cell is locked, data spreading is not reliable. 

• The member alias is removed when you add a member formula. 

• On the Planning Desktop, selecting Help > About Hyperion Planning displays the incorrect 
Planning release number. 

• You get an error if you try to set Two Pass Calc on any dynamic calc time period dense parent 
member. 

• When using the FormDefUtil utility to import data forms, the Hide POV setting is not imported. 

• When you assign access permissions for multiple users to a business rule in Administration 
Services, the users you select do not always move correctly to the Selected Users window. 

• When adding a new Account member, the 4-4-5 Distribution option does not display; the option 
does display, however, when you edit the new member. 

• An LDAP user who logs into User Management Console may be given more permissions than 
he/she is granted. This problem occurs because the roles associated with a sibling group of the 
user’s group are being granted to the user. 
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• When assigning users to groups in nested Organizational Units (OUs), Shared Services does not 
display the complete group membership information. It only displays the group membership 
information defined at the top level OU. 

• Where circular group memberships exist at nested levels, accurate group membership 
information is not being retrieved. An example of a nested relationship is where Group A is 
defined as a member of Group B and Group B is defined as a member of Group A. A user is 
assigned to be a member of Group A; Group A is in turn a member of another group (this is a 
nested group membership structure). Under these conditions, the user's group membership to 
A will not be displayed within Shared Services because A has a circular membership with B. 

• Where circular group memberships exist (Group A as a member of Group B and Group B as a 
member of Group A) and you are provisioning, the system freezes when group membership 
APIs are being called within Hyperion – System 9. 

• Where users have identical common names, internal processing errors occur during 
provisioning due to the way in which Shared Services searches for those users. 

• Where circular group memberships exist, out-of-memory exceptions are generated. 

• Shared Services cannot communicate with other Hyperion products over a Secure Sockets 
Layer (SSL). 

• Group filters do not work for LDAP.  

• During product upgrade, when the products re-register as part of the upgrade process, the 
registered roles are not being updated with the upgraded product version. Therefore, 
administrators cannot view the roles associated with the upgraded product in the Shared 
Services interface. 

• Essbase freezes when concurrent CSS calls are made during authentication. 

• If a user is assigned to groups in a nested organizational unit, those group relationships are not 
processed within Shared Services. 

• Users are not being successfully provisioned under the following condition: they exist in 
external directories that are configured in the CSS configuration file after another provider has 
been configured where circular group relationships exist. For example, the configuration file 
specifies these directories in the following order: MSAD1, LDAP1. If MSAD1 contains circular 
group relationships, users defined in LDAP1 will not be provisioned. 

• When logging into Hyperion – System 9, users belonging to groups that have circular 
references do not show any roles associated with those circular groups. 

• In groups where circular relationships exist at the root level, group hierarchy information is 
incorrect. 

• If circular group relationships exist, login to Planning and Hyperion® Foundation Services 
freezes. 

• If circular group relationships exist, APIs are not returning accurate group membership 
information. 
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• After executing for a long time (such as 60 minutes), business rules time out in the Web 
interface. You can now set a timeout period in the HspJSHome.properties file, after which 
the business rule switches to asynchronous mode and is executed in the background. Users 
can then select Tools > Job Status to view the status of business rules currently executing 
in the background.  

To set the timeout period for business rules, add these settings to HspJSHome.properties: 

HBR_MAX_WAIT_FOR_RULE – Sets the interval to wait before running business rules in the 
background, in asynchronous mode. The default is 600000 milliseconds (10 minutes). Users 
can check the Job Status page to determine business rule status. If this property is not set, 
business rules always execute in synchronous mode. The minimum value is shown in this 
example: <APPNAME>_ HBR_MAX_WAIT_FOR_RULE=600001  

HBR_MONITOR_DELAY – Sets the interval for checking business rule status. The default is 
300000 milliseconds (5 minutes). The minimum value is shown in this example: <APPNAME>_ 
HBR_MONITOR_DELAY=300001  

• The Business Rules Launch button is still active after launching business rules. 

• Synchronization fails if users are provisioned indirectly with only the Shared Services role. 

• Users provisioned to Planning through Groups get access to all application calc scripts. This 
fix is only available if you use Essbase 9.2.0.3. 

• When users or groups are moved within an MSAD authentication provider or when they are 
moved from one provider to another, their identities are not updated automatically in 
Planning. 

• The HyperionRMI_Classpath.properties is not correct after installing Planning 9.2.0.3. 

• When using the Planning ADM driver, sometimes the individual reports are not sorted in the 
same order as listed in the book report table of contents. 

• Large member formulas for the Scenario, Version, and Currency dimensions are not saved 
or validated. 

• Planning performance slows when you copy information from Excel and paste it into 
Planning forms on the Web. 

Defects Fixed in Planning Release 9.2.0.2 

• Occasionally a user who was provisioned through a group cannot log on to Planning. 

• If SSL is enabled with the Hyperion Configuration utility after auto-deploying the 
application, you cannot connect to the WebLogic console or Planning using SSL. 

• Smart View does not allow more than 256 characters in Smart List drop-down lists. 

• Planner user types cannot view task list instructions or task instructions. 

• You cannot import access permissions for View users with the ImportSecurity utility.  

• On Oracle 9.2.0.7 systems, after deleting a shared member, when you refresh the 
database, you get the error message, “Unable to locate parent for update”. 

• Copying and pasting a large amount of data from a Microsoft Excel worksheet to a Planning 
data form takes too long. 
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• In data forms, calculations on accounts whose time balance property is First, Balance, or 
Average, ignore their Skip option setting—Missing, Zeros, Missing and Zeros—instead, 
treating them as if they were set to Skip None.   

• When launching a business rule from a data form, the progress bar is not animated.   

• Refreshing security from the Planning Desktop fails when applications have large numbers 
of users (for example, over 1,400).   

• Some data forms cannot be loaded. 

• When using the ADM driver, sometimes aliases for shared members do not display in 
reports when they are selected using member relationships (for example, IDescendants and 
Children). 

• In Smart View, aliases for shared members are not displayed in the POV or page axis.  

• Sometimes new users who are provisioned in Shared Services as part of a group are unable 
to log on to Planning Web. 

• You cannot create a Planning application from the Desktop if the path to the CSS.XML file 
contains https (for example,  
https://localhost:7002/interop/framework/getCSSConfigFile).  

Defects Fixed in Planning Release 9.2.0.1 

• To deploy Planning successfully when using Windows 2003 Itanium and WebLogic 8.1.4 – 
1.4.2 sp 4, you must install JRockit 1.4.2 service pack 8. Windows 2003 Itanium does not 
work correctly with the version of JRockit that is bundled with WebLogic 8.1.4 – 1.4.2 sp 4. 

• When a UDA is added to a year, the UDA gets added to all years. 

• When users who are the only members in a group are removed from LDAP, refresh fails in 
Essbase Administration Services. 

• When you manage Planning dimensions in User Management Console, the top portion of 
the Planning page is obscured, and navigation tools are not available. 

• An error message displays when you deploy applications to WebSphere 5.1. 

• When you open a business rule in Essbase Administration Services, the format of the rule is 
not readable. 

• The essbase.properties file is deployed to the UTILS directory instead of the Planning 
deployment directory. 

• The Welcome panel in the Planning installer displays UTF-9 code.  

• Adding a member formula causes Tomcat or WebSphere to freeze when using the Hyperion 
JDBC driver on an Oracle database with NLS_CHARACTERSET of WE8ISO8859P1 or 
CL8MSWIN1251. 

• You cannot view Related Content links from Hyperion Reports after the Planning server is 
registered to Shared Services. 

• In Japanese, you cannot launch WebLogic 8.1 with Planning. 

• Aliases do not appear as column headers in the supporting detail window. 
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• After you register Planning with Shared Services, if you log in to the Shared Services 
Console and restart the Planning and Shared Services servers, you see this error message 
after you log in to Planning: “Registered app is not active at the moment. Please consult 
your system administrator.” To work around this, register the Planning application again in 
Shared Services. 

• In Russian, a Page Not Found error displays when you manipulate the Form Design tabs or 
buttons. 

Defects Fixed in Planning Release 4.1.1.0.2  

• Users and groups are now synchronized successfully. Users deleted in an authentication 
provider are now also deleted from Planning. 

• After users and groups are synchronized, a new message confirms its success, and if there 
are errors, directs you to the Planning log for specific information. 

• Changing the name or property of Period, Year, or Currency root members prevented 
Essbase from generating security filters. 

Defects Fixed in Planning Release 4.1.1.1  

• After you run a business rule, Smart List values are displayed in the data form as numbers 
instead of text. 

• Deleting an alias table that is selected on the Preferences page causes the Alias column on 
the Dimensions page to display as blank instead of displaying the alias member names from 
the default alias table. 

• If you do not select a database outline for one of the business rules in a sequence, and you 
specify to hide the execution database prompt in the Sequence Editor, then launch the 
sequence from Planning Web, you are prompted to enter the execution database even 
though you hid it in the Sequence Editor. To work around this, select an outline for the rule 
and save it again. 

• On the Member Properties tab for Accounts, now you cannot select and save a source plan 
type unless it is a valid plan type for that member. For non-valid plan types, this message 
displays: “The Source Plan Type selected for this member is not in the subset of Valid Plan 
Types.” 

• On the Enter Data page, you can now expand and collapse members when there are 
multiple dimensions on an axis, including members that span multiple rows or columns. 

• Previously, you could not select cells in the Enter Data page. You can now select cells 
normally to enter or update data. 

• If you are upgrading from a release earlier than 3.5.x, you must first install Hyperion 
Planning Release 3.5.1 and run the migration utility to upgrade your applications to release 
3.5.1.  Then, follow the instructions in the Hyperion System 9 Planning Installation Guide to 
install and upgrade to Planning 9.2. 
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Defects Fixed in Planning Release 4.1.1.2  

• When users don’t log off when closing a Planning session, memory isn’t released. 

• When member names contain spaces or special characters, Planning encloses their names in 
runtime prompt values with double quotes, resulting in your not being able to launch the 
business rule from Hyperion System 9 Essbase Administration Services™. 

• Large data forms load slowly. 

• With Business Rules, user synchronization is very slow. 

Defect Fixed in Planning Release 4.1.1.2.1  

• When running business rules, it takes a long time to select an entity for the runtime prompt. 

Top

Tips and Troubleshooting 

Working with Dimensions 

For applications containing exchange rates, if the data storage for root-level dimension 
members (Entity or other user-defined dimensions, excluding Account) are set to Dynamic Calc, 
the exchange rates are not populated in Essbase. This applies only to the root-level dimension 
members and not when members of the dimension are set to Dynamic Calc. 

Working with Essbase  

Many Concurrent Business Rules Users 
If you experience a problem connecting to Essbase when a large number of users (for example, 
50 users or more) are concurrently using business rules, you should configure the essbase.cfg 
file for Essbase, in the bin directory:  

1. Add these lines to the essbase.cfg file: 

NETDELAY 800 

NETRETRYCOUNT 1000  

LOCKTIMEOUT 60 

AGENTTHREADS 200 

AGTSVRCONNECTIONS 5 

SERVERTHREADS 50 

2. Save the essbase.cfg file.  

3. Stop and restart Essbase to initialize the changes. 
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Creating Member Formulas 
The ability to create member formulas increases flexibility in Planning application designs. 
However, you should use this feature with the expert advice of your Hyperion Services 
consultant. 

By adding a User-Defined Attribute (UDA) to the member, you prevent the formula from being 
overwritten when the application is refreshed. You need to log on to each database associated 
with the Planning application and create the member formula with a UDA.  

The syntax for the UDA is as follows: (UDAs: HSP_UDF) 

where HSP_UDF stands for Hyperion Solutions Planning User-Defined Formula. 

Note: You can assign the HSP_UDF UDA to members from within Planning, but you must 
unassign them directly in Essbase. If they are unassigned through Planning, application refresh 
does not unassign the UDAs from members in the Essbase outline. 

For more information on creating UDAs, see the Hyperion System 9 BI+ Analytic Services 
Database Administrator’s Guide.  

Modifying the Essbase Outline 
In general, Oracle recommends that you work exclusively with the Planning interface. In certain 
limited cases you can work with the Analytic Administration Services console. Use the following 
guidelines for working in Essbase while logged on as a supervisor or the Planning application 
administrator: 

• Do not change dense/sparse dimension settings or the order of dimensions in Essbase 
Administration Services; use the Performance Settings tab on Planning Web instead. 

• Do not use the following attribute dimensions: Boolean, Numeric, Date, or hierarchical Text. 

• Do not use Link Reporting Objects (LRO). 

• Do not change the Time Balance default settings. The defaults are Ending for Balance and 
None for Flow. 

• Do not change the Variance Reporting settings. These are preset for all account types 
except Saved Assumptions. For Saved Assumptions account types, either Expense or Non-
Expense is a valid setting. 

Hyperion® Reporting and Analysis – System 9, Planning, and Hyperion® 

Financial Management – System 9 Roles  

These roles do not apply and should not be assigned to Planning users who access Financial 
Reporting or Hyperion® Web Analysis – System 9 through Reporting and Analysis: 

• Dynamic Viewer 

• Interactive Reporting Viewer 

• Job Manager 

• Job Publisher 
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• Job Runner 

• Metrics Analyst 

• Metrics Editor 

• Metrics Viewer 

• Personal Page Editor 

• Personal Page Publisher 

• Smart Form Publisher 

• Trusted Application 

Top

Documentation Updates 

This section provides late-breaking updates to the documentation. 

Hyperion System 9 Planning 9.2 User’s Guide 

Chapter 4 – Entering Data 
In the Tip on page 43, the reference to “Enable Most Recently Used Selection” should be 
changed to “Remember selected page members.” In addition, this feature is a list, not a check 
box.     

Tip: From the Preferences page, select the Display Options tab to select Yes for Remember 
selected page members. Planning remembers the last page and POV member selection, so the 
information is available for each data form you select. 

Chapter 9 – Setting User Preferences 
In “Remembering the Last Page Selected,” two references to “Enable Most Recently Used 
Selection” should be changed to “Remember selected page members.”  

This topic should be included before the topic on “Enabling Warnings for Large Data Forms”: 

Remembering the Most Recent Page Visited 
Use this preference to have Planning remember the page you visited before logging out.   

To remember the most recent page visited:  

1. Select File > Preferences, and select the Display Options tab. 
2. In the Other Options section, select Yes for Remember most recent page visited. 

3. Click Save. 
The next time you log in, you go to the page you viewed before logging out. 
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Hyperion System 9 Planning 9.2.0.3 Administrator’s Guide 

Chapter 3 – Setting Up Access Permissions 
The Refresh Users and Groups button was removed, and a Migrate Users/Groups button was 
added. Step 5 of “Adding Access” should be changed to: “Click Migrate Users/Groups to update 
the Planning repository for users and groups that were moved across OUs (operating units) or 
deleted from the external repository.” 

Chapter 4 – Setting up Security 
If a Planning user has different roles in different Planning applications, the user’s highest role is 
used in Hyperion® Business Rules. For example, if a planner is an administrator in one 
application and a planner in another application, the planner becomes an administrator in 
Business Rules, and can create, modify, and launch any rule in any application.  

Chapter 7 – Using Data Forms 
In “Setting Properties for Business Rules,” the reference to “Remember the Last Page Selected” 
should be changed to “Remember most recent page visited.”  

Chapter 12 – Working with Applications 
In “Setting the Application Defaults,” the second bullet in Step 4 should include information on 
remembering the most recent page selected. 

Chapter 14 – Menus, Smart Lists, UDAs, and Formulas 
Replace the description of the text box for Smart Lists and Menu Items with: 

Enter a unique name that contains: 

• Only alphanumeric and underscore characters (for example: Position) 

• No extended characters 

• No special characters or spaces 

Note: Labels can contain spaces, special characters, and extended characters. 
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